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iGerber Data Inputs and Outputs

Gerber Files < > >
Aperture Files < > >
iGerber

BOM >
CAD-XY < > >

TN NN YN O

NC Drill File < >




1.

do LB T, (Gorber #AFATH 22 A, T A AT 71 LA,

Gerber Files

<>

*NFSLAX23Y2 3%

*%MO T N*Y%

GO1=

D12*

X10382Y7902D02 =

X10429D01% ‘K\\\

Y7772D02% g D02 %7k D-Code
X10382D01+

X10615Y7843D02+

Y7890D01+

Y10149D02

¥10197D01+

X10429Y10209D02+

Gerber File 4 CAD Layout %% Design & —3k PCB . F 5, Mamét b 2 40 %

BA%, T2/ F T Gerber File 2R K, BUAKR K A 42 4 PCB

BT k.

Gerber Fie #5% MM X2 EA LATHK, RIBEXTHH RS-274-D 5

RS-274-X AP,

% RS-274-D: XAy #3218 Gerber File #X,, B 4 &N L4734 E 2 D-Code,
Hb A X Z D-Code & % 4 — A 452 k380 D-Code, wARFPA%E AR
#4 Aperture Files.

% RS-274-X : pbA M F R A R BEIAMX, 5 RS-2T4-D RRKIZIAFE, £FE
J% Aperture Files #4-f& Gerber Files ¥, MM EI ALK AL, £
Input B4R 5 th 4,

Aperture Files
<>

D11 ROUNDED 3.937 3.937 0. 000 MULTI
D12 ROUNDED 5.000 5.000 0. 000 MULTI
D13 ROUNDED 5.906 5.906 0. 000 MULTI
D14 ROUNDED 6.000 6.000 0. 000 MULTI
D15  ROUNDED 7.000 7.000 0. 000 MULTI
D16 ~ ROUNDED 1. 087 1. 087 0. 000 MULTI
D17  ROUNDED 1.333 1.333 0. 000 MULTI



Gerber Files /& & A 4%, 9 Aperture Files Mk EMIkE K-]v. Aperture

Files A& £ %4 D-Code. Shape (F54K) . Dimension (K ).

% D-Code: ST #VA T @ &9y & % £ I, *. APT, * . REP, *. LST, *.GAP, * APR
% . D-Code F D01 D09 A A & BKIAME, X 2IZHE _EBKIAE, 4 D01
AAITATHE, D02 Rk, F5. @ D10 WB1EZ Layout KAF b 47
Z A4,

% Shape :Shape AMIK, 4oF Round (AH), Rectangular (KFH) &,

% Dimension :Dimension A K/, BEah X5 YZRE.

. BOM

<>

C0101999 C1

C0230100 C2

C0500417 C3,C18, 21, 24, 28, 31

C1440339 C4,C12-C17,C19, 20,22, 23, 26, 30,C32-42

iGerber ¥ ¥A Input BOM(Bill of Materials) P& A Z%H#, 4e#t5 2 Name,
SLIRE RASA sm t 25 LHF].

. CAD-XY
<>
C42 2588 1825 0 270 00 CAPSMD {0. 1UF}
MT9 2600 1750 0 0 00 FIDUCIAL
MT3 2750 1750 0 0 00 MTHOLE1
MT7 2425 1750 0 0 00 MTHOLE1
R30 1913 1725 0 180 00 CAP0603

CAD-XY ARM & & 5 AFrfF, A E T EHAALTFE Cerber Files
A, YAk iGerber HIMEZ iR E.

. NC Drill File

<>
T1F095S3
X00325Y00872
X00162Y013
X00162Y01375

StA4EIUAS, A PCB AR T IR BT 45 IUALPTAE R Z 4448, iGerber fE4|4F AT s



MER IS, R RERHEZ R,

CAD /=4 ¢4 Gerber Files A $AA5E, &ARE AN, BFHE—/HEE
RE—A-1E 4 E ., iGerber st & ZEGAL I 7 ik 2 RE 6, 4% 8 # IR IEAAIX
BRENHLAR, T2 ER, 24

6. Bottom Layer:
— AR, B RN EZ— &,

7. Top Layer: ZHfFE.

8. [AIE%44 2 (Top Mask. Bottom Mask): FRIRFLRA B R I &3R04 &,
5 Top Layer & Bottom Layer A8 BB 449 —AFP4hgh &, [AIFS ié/x\}i';z\_ Fﬁ FE
WA ) RAL R R E L, M PCB AARRYRLEE, FrikE a3y, @R A
SFGER S, LIV REARES, REBRRAET R RIFERM,

9. Ground Layer: 3B, W&k BB H A FH E, LEMAZEANEWEZ4H.
M B L@ w A thermal 3U.

o009 Thermal Hole
). 2000 l ’/
' @ y»| Ground/Power
) e .

10. Power Layer: w/RE., &M FE3EHE

11. X5 B (Top silkscreen, Bottom silkscreen): X F B350 0F64 KA
AR,

12.Middle Layer: W& E, % EHMAR FRILRE,
BEAER P, F22F X H Middle layer #= Power / Ground Layer, Middle

Layer B#3 M Fi& AIE K, @ Power / Ground B 4 &4~ thermal, 4o FF, &%
AR KA.



eao00OOBLE

.............. -
o ¢ > [ Middle Layer

File Edit CAM NC Test Zoom Draw Grid Jump PDFs Seript Window Help
Uszer "
X 4307722
W -2.3TESE2
Abs "
H 4307722
Y -2.3TESE2
Rel "
W3182722
Y -2.501552
" a o 4048164
T, Marked Data
Padz+Parts: 0
- H _
e : Traces: 0

Layer Status

NN T
e ]- oo 1™
o] fr ] Joor |
o] fr ] o7 ]
] o |
o ] Joo ]
e ] o ]
P 1,

Layer List

W o~ M M s W M

NC Drill

Aperture Lists
Drill Racks

GC-FLACE “iewer/Editor: Edit Both{pads+parts traces) [334Kb)

| | @ =14 B || E)iGerberdos - Micr. | O B3EE - Bon.. |[BocriacE- oo, | 510 RGOS 2B RMo708
LB iGerber FBZXE T RE, WM& TAXA 3NLATAEARAKRZIE A,
SR A

1. Layer List




: Laer List

# Color Status Pol. List File Name/Comment X Offset Y Dffset "

1 'lJ E \E:‘\gcnlace\euamples\ncdrill.drl ‘ j ‘l].l]l]l]l]l]l] Hl].l]l]l]l]uu‘ L
2 * J (C:\geplacetexamples\spasttop.pho | j 0.000000 | [0.000000 |
3 'UJ IC:\geplace\examples\sikiop.pho | j 1:0.025000 0.000000 |
4 DUJ IC:\geplace\examples\layer!.pho | ﬂ 1:0.108020| 0.000000 |
5 J D IC:\geplace\examples\smasktop.pho | j 10025000 [0.000000 |
6 'UJ \C:\gcplace\examples\silkbol.pho ‘ j ‘-l].l]zﬁl]l]u‘ ‘I].I]I]I]I]l]l] ‘
7 J IC:\geplace\examples\spastbot pho | j 10.000000 | |0.016250]
8 DUJ IC:\geplace\examples\layer6.pho | j 10.108020| 0.000000 |

* Color: BArv A —RAEE5—ALK. B EE&TPADZFHE, A& %AT Trace
ZHE., E—REREBAFEARETARRLAE,
% Status :iGerber WA KA, ok 3 FFAEX.
Hide >¥4% & F&
View >TAF R BH, 2 AR4844
Edit > T EZEH, FTVl%hmiE
% Pol : M
P >RAEIAS, HIUS A4S, KIK04E5L34 B2
U >RAEILAS, (23UE A 4, Plde T B ILR AL
+ >4k Gerber File, J& K B AHER
- >4k Gerber File, &K BHAHRA
c >%& Gerber File, &K Bt A#| 2
% List : fEk, 4=k Gerber File, W|#rAHAB%F A Z Aperture File, #8
Bl &9, 4= NC Drill, R4 At Drill Racks.
% File Name/Comment :#y A Gerber File Z 3442, A& Frk ik Tvliks®
#3542, EBE Load NG, 1ETAKIZRLARBUR A TEZZ LR,
% X Offset/Y Offset : HEAKEELHAETE, HXAAE/HZ XY

(A

2. Aperture List



: A pertore Listz

@i i| [C:A\GCPLACE\EXAMPLES\APERTURE._APR |>| —

al]2|| |ﬂ
al]3|| |ﬂ
an4 | | 5] _

Cloze I

% Aperture List 488 Gerber File é9FF K mA Ar X 7. 4o XA —/> Aperture
List B ({R3% 4 a01), W FiA Gerber File ¥4#Fsb— Aperture List.
4o XA %/~ Aperture List B, W3R X445 Gerber File A8 &%t 5L
(%)%= Gerber File : a0l. pho, W|%fji Aperture List : a0l.rep). =
Gerber File #& X A RS-274-X, W|* T4t Aperture List, iXBFASZE Anik,
)G A% A 1iT—/" Aperture List ¢,

3. Drill Rack

& Duill Racks
w01 | [UNTITLED £ —
oz || £
w03z || E3
4 || E2
| Close |

Drill Racks Z% 453X K/s, #@FAENC Drill AAEmEI, FREEL
Drill Racks, #RBPfE LB ZZTE. £/ NC Drill 42 b 2 RIBELEILAS
A B —/> 101, SLEFA94ESLR DB AR ZAL T8, HBE—ANDKADF—
B, AL Z KN IR R AUE A dd0L. rep B E T, #EHR ERZ 01
HAHEHE—IRER—F MmN, T E:



N TITLED
Code Diameter Spindle Feed

’n—ﬁ o [0-000 mil ] il
T2 |25_nuu mil |u |u_uuu mil
T3 [#0.000 mil |0 |0.000 mil
T4 |123_uuu mil |u |u_uuu mil
|| TS |14E_uuu mil |u |u_uuu mil .
Add | Bemove | Remove Unused |

Compress | Sort | Eruﬂ!ﬁhlinkl

Invizible | Units I Go to. .. | Print |

BT RNB4F P ABXA A 2|69 2 i

File (#%)
% Load Layers (lm#&KH &) :

Diata type
Gerber - oK I
Drill _I
Hout Cancel I
HPGL
Emma/Quest Help |
[Auto
DFF
DxF
EDIF 4.0.0

1% Load Layers 3L L Data type, TV A E AL, Ko 2ik4E
Auto, Z EdIAz admbe T

Layers: ﬂ 1] I
Error File: | ﬂ Cancel |
ey width/height inch):  [0.000000 Help |
[~ Stop on MO0, MO1 Print.__ |

Units |

LW Layers 7T vAi£#FE & Load Z Ed,

% Unload Layers (BB E®m) : BHRAEEZZER
% Load CAD Centroids (hm#k CAD-XY) : Ae# CAD-XY EAF & & A 4F



% Restore All (Be#k TAEA% . GWK) : AmX iCerber A GWK TA4%
% Setup Physical Layers GREZWAE) (X LA CEAAMAZE®, Flde
4 BE#.Z PCB, 1% T 0 454530 E . Top Layer. &K &. Bottom Layer.

Retup Fhossical Lavers

Plated Through Holes/Routs:
Unplated Through Holes/Routs:
Physical 01:

Physical 02:

Physical 03:

Physical 04:

Physical 05:

Physical 06:

Physical 07:

Physical 08:

Physical 093:

Physical 10:

Physical 11:

Physical 12:

Physical 13:

Physical 14:

Physical 15:

Physical 16:

Physical 17:

b
ok =
j Cancel —> ﬁﬁ? M 53|

o b |

¥ Print...

Top Layer

Intl

Int2

K KA

Bottom Layer

f
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

I;&ILI;I;ILILILI;&IL?’&

Physical 18-34 |

* Set Layer GRZE®) : TR ZE@HmZAARES, 2@ FH, Status GRRZE) 7T
15 % Hide. View. Edit.

Bet Layeris)
Layers:
Status:
Image Polarity:
Dol
Apertures:
Pad color:
Fad colorn selechon:

Trace color:

Pad Tool:

Trace Tool:

Phyzical Layer:
|

lrace color selection:

E >
MHo change vI Cancel |

‘I.I"ifgw I Plated " Unplated Print. .. |

E dit
No change ;I

IHD change LI
[ 2
INlJ change ;I

I_J
I_J

IHD change

% Reorder Layer GAE) : TR EX—EeRfAFiA#E, 4o FHE, Layer AKX



KBS, Above A BIFEZ M.

Reorder Lanrers

Layers: IE ﬂ | (1] 4 I
Above: |1_ﬂ Cancel |
_ Hep |
_ Puint..._|

% Copy Layer 2N Ed) : TAENE —2 E@mZ A4, 4B Source Layer
A kB ZE, Destination  H 4| Z AL EHKL.

Copy Layers. .

Source Layer|[z]:

E ok |
Destination: Iﬁ Cancel |
|+ Pads+Parts Help |

V' Traces Print.__.

* Write Direct (FAASE) : sbIMB TVAFAANXZIASE, EREHRINTH
ZHEa, T EAR Y S XA LA

FE B4 49 % Fabmaster FATF ZA4% (+.asc), E-&T /£ Fabmaster 4k
W2 s, DARHATEC TAEZ gk 4,



Fabmaster FATF

Output File:
Deszcrption:

Dnll Layers:

Top Circuit Layer:
Bottom Circuit Layer:
Internal Circuit Layers:
Top Part Layers:
Bottom Part Layers:
Contour Layer:

Top Silk Layer:
Bottom Silk Layer:
Top Mask Layers:
Bottom Maszk Layers:

Documention Layers:

Work Space :

Coords:

4o F

OQutput File :
Drill Layer :

Work Space :

Coords :

o >l

k2] 152 (2]

o]
I

+ Bed Extents

(" Abs * User

T E.
AE LAY
Top Circuit Layer :

Top Layer
IR, @ FiXAH Layer Extents (PCB & ¥)
AT R, BEAE R Abs (483t A AF)

% Checkplot (2 H) : TTHE ey Edmse

Checkplot

Layers:
Plotter:

[ Fit to Page
[ color
Style:

draw panels:

I+ Padz+Parts
[+ Traces
X Scaling:
Y Scaling:

Oxerlap [inch]:

" Layer Extents

|52 |63

" Contour Extents

114

| Print Manager

| MNormal

* quick T Full
0.0710000
1]

[1.000000
[T-000000
[6.500000
[17-000000
[0.000000

[+ Edge Adjust

X Offzet [inch):
Y Offzet [inch):

Cancel

Help

Setup Printer

Units

[0.000000
[0.000000
[0.250000
[0.z50000



4w BB, Plotter TR ELBEMAE LK I, Fit toPage K EHIKE LK,

color AATHP B H &,

 Query (F14) : 7 & #)E4F R PAD, Trace ZH#F, FERT LM e BB LS
)2 R & Mark) ,

% Bed Size : B4R IRZ K IRE.

. Bdit (%48)

% Undo (@3] L—3)4F) :Undo THHEDE £ L—&, {22AXRH]—K,
Fik—4 Undo F .

* Cut (A TF) :BRAFLET T, wRET—HEMLE, MNEAFEFRLT T
ZAR, LR AEMGZEZE, B iCerber KA MR 454, HA A,

% Paste (ML) FRAMNZIHXT TR, Al L, Ar2ZNERR
—E.

% Paste to(ME%]) : XM E—3 X Paste, {2 RF &2 HNEZR] 54— &,

% Array Copy+Paste (3523 Mk L) : sbp 4t B ¥ —st 2 R @ 45, ik
I HEAR T My NBLL 2 X&Y AN

Array CopytPaste
X EE%T%E Z%& E ¢——* copies:
¥ step [inch]: 0.055548 Cancel

El

Help

TI
U

¥ copies:
X i i [T ‘_/I step (inchl:  [0.130538

Print.___

Units

% Editing Mode (3#42X) : 4T B

Editing Mode

Edit: Both[pads+parts traces] LI

L : Pads+Parts -

Layers Traces ﬂ Cancel |

[T Auto Snap Bothlpads+parts traces] Help |
Layerz[panelize]

Hew arcs/boxes: T LW * W Print.___ |

Box comer radius [inch]: Iﬂ.ﬂﬂﬂﬂﬂﬂ Units |

[” DOrtho [hotkey T

J£ Bdit ¥ T vl 4-px, Pad+Parts. Traces. Both(pads+parts+traces) .
Layers (panelize)

Pad+Parts : ZAFA= PAD X, AKX T R 4% FRML PAD
Traces : KHMAEX, AKX T REiEHmELNL

Both (pads+parts+traces) : EAF. PAD e LK 343 7T vA 4545

Layers (panelize) : #EAEX

% Mark : ¥ HAFIERZ AT R A



% Mark All :34PiR X5t %2 @
% Selective Mark/Unmark : st MR & /BRIE R G, T ANE ZHEZ A0
%1z 8, 4= Net numbers (W5 #), Tool (iGerber D-Code Z 5 4%) .

Selective MarkTTnmark

: _Concel_|
[ oo |
_ pint..._|

2]

Action % Martk © Unmartk  Invert
¢ Parts Cancel
Parts | Help

¥ Traces Print._.

¥ Pads+Parts

Het Point Type:
it of BointzfHet:

Met numbers:

=2
7]
Q
=1
1]

% Unmark : BU{ R G,

* Offset (1A%) : ¥R &2 fAzAb.

% Rotate (7e4%) : T H R @ 3 RAEZ x4t
% Mirror X : 2} X=2#& Mirror,

% Mirror Y : %} Y=24& Mirror,

% Scale : TR G & FMALK L D ZAZE,

CAM

% Automatic Centroid Bxtraction (g #h ¥ & 848H) :sbhstTAK R G
Z 3 B SUREM, AR E AR b, 2R IR ) hE R REE IR
SMT &4, o BLE SMT RAFMp x 2 PAD s/ 2%, Tt Rtk A 1A,

]
QFF onentation: Right Cancel I

F ]
PLCC onentation: IHight - I Help |
S0IC orientation: IHight - I Print.__ I

Find SMT componemnts

Hew parts layer:

S0T23 onentation: Right

Pazzive and Polar orientation: Right
Mot Placed




THEARREZHR

New parts layer : ¥ FAZETMHHE R —FWED

QFP orientation : 4o ¥ £4FZ Right, ZFLEMHF — AN
FALA B, MEFZA X 4T H

UL

PLCC orientation :

Example of a PLCC

SOIC orientation :

Example of an S0IC
SOT23 orientation :

Example of an SOT23
Passive and Polar orientation :

Example of a PassivesfPolar



% ldentify Part (& XRMH LA : ML TRE, BFEZLT LM —
LAk, TAEEA CAD-XY A E MBI T, 2B FE (Silkscreen) sk
e, MEMERLFEERMHERE, B iGerber #4T OCR LF EF
WIEIN, 4o T A:

Silk Layer : X5 &

Part Layer : XM E

Width : XFEPE—FHRZIKE X4, #4514 inch)
Height : XFEFE—FHRZZE (Y 4h)

Identify Part(z)

Silk Layer: IE_ﬂ
Part Layer: Il]_ﬂ Cancel
Width (inch]: [0.03300° Help

Height [inch): [0.04500 Print..._

¥ Dverwrite Units

it

Ui

Expected Characters: |

[T Accept Alpha-Mumeric-Alpha

% Check Reference Designators (BHIAEMH & 4R) :

Top Part Layer ILayer 10 d
Bottom Part Layer INune d

Cancel

¥ Check Duplicates " Compare Top and Bottom Layers |

W Check Blank " Fuzzy Check About

REFDES FORMAT
1 Match
(' Differ

I T

TARRINEAF L AR TR T E A

% Merge CAD Centroids (&F R &)  THEM4EL CAD-XY B EMt
¥ HATIR S, FRIN AR —E@,

% Teach Pattern (F3) @ X EM) : K34 2% PAD Z SMT RAFH T
Automatic Centroid Extraction k&, /2 € ik SMT 5 DIP K 4F,
% b b kL.

Teach Pattern

Save as: 140.000000 0.000000 DD ﬂ
Add to List: |5|n.r|'|' Pkg. LI Cancel I
Diill Diameter (inch): W Help |
Find Datum Bazed On: IEHtents ;I Print... |
Get datum from: " Pads+Parts 1 Traces (% Both[pads+parts.traces] Units |

Order Pins: INunB LI




Save as : B GHFH M, B—RHZXHELFHE, ZHFRESTAIRK

43

Add to List : RMHZAL, RI;o4 A M Pkg (SMT &) 5 TH Pkg (DIP

EAF)

Find Datum Based on : ¥4 Extent (), £ TEM4+ & XLER G

22 ES

Get Datum From : RAF & EZARYE, T4 PAD, K345 A4 .

Order Pins : ZMBpRFZ 2 X, CCW Ai#ar4t, CW A)er4t, Maunal

F e L.

% Scan and Replace (324 Fe3L &) : E3h4e= Teach Pattern & XL T EM4Z
PG, AR EAR—HEE, REhFRAED, WHEFLMARE,
W) 3 68 £ 2ARIE LG FL ka2 R & Z 5t % (Pads) , mEEdk s B4 (Parts) .
40T B, Newly Taught A# R4 4344, Same List AIRAT—FhEMFE X

Mz aFb3EF.

Batch Patterns

Select: [All - 0K I

= Unscanned _I
Mewly Taught Cancel |
Taught
Manual Help |

LI Print.__. |

% Auto Convert Sketched Pads (A sh BB ZIF.5) b sEAF R
Z PAD BV REEZ PAD, Jo FFI AT, %44 BAC HEHK A,

=

.2 B TracestH S R E. PLDSARE— =
EPAD @ﬂ@@ $ERE A SERESPAD




1.

Auto Convert Sketched Pads

Top Mazk Layer|z]): I

114 I

Bottom Maszk Layer|z]: I
5|
o 5]

Top Solder Paste:

Bottom Solder Paste:

=

Cancel |
Help |
Print___ |

Units |

Top Circuit Layer: Iﬂ_j
Bottom Circuit Layer: Il]_ﬂ
& Mone Solder Paste
= Mone Solder Paste

" Solder Mask
" Solder Mask

Top llemplate Layer:
Bottom llemplate LLaver:

[+ Conwert Template Layer
Radiuz [inch]:

Length linch]:

Il]. 005000
Il].1 50000

% Replace Marked : 3% 4| & SUEAM. sb3h 682 A 305 F 3 2 SURMH R,
38w AT LR A A A B T R BT, ] bR T VA SR BT R B R AT
Jip ¥ S — B A

% Explode Custom Aperture GE/JR A EAMHP) : $hik T2 A B2 AR AT,
B A sy fe ik Undo, #CFALERAF (Part) R R E MMy (Pad) .

K Sort (HEAF) 1 LI RETT AR R G 2T R, AT BIARHT, MR ALER
T/ Query R E ¥ 27,

Sort 1: A Sort: ™ Ascending  Descending
Sort 2: Iskip LI Sort: ' Ascending ¢ Descending Cancel I
Sont 3; ISkip ;I Sorit: * Agcending © Descending Help |
Sort 4: Iﬁkip ;I Sort: ' Ascending © Descending Print___ I
Sort 5: ISkip ;I Sort: % Ascending " Descending Units |
Sort B: Iskip ;I Sort: ' Ascending ¢ Descending
Sont 7 ISkip ;I Sort: % Ascending ¢ Descending
Sont 8: ISkip ;I Sort: % Aszcending ¢ Descending
Sort 9: ISkip LI Sort: ' Ascending ¢ Descending
Sort 10: Iﬁkip ;I Sorit: * Agcending © Descending
Sort 11: ISkip ;I Sort: % Aszcending ¢ Descending
Sort 12: Iskip LI Sort: % Ascending " Descending

Band wadth [inch):

[0-000000
4o F Bz Ref. Deg. | A B & &t .2 KA 4 5 H .
% Register Layers(F&ERE) :THHBENEE E,
BEAES ZR A, AT EEMAT.

MERKEEEZA

Test
% Extract Netlist GE#M%) : st itk bt ke 5 ZAR R, T2
S be, T ZAE4E Gerber File P A BEL&L34ikil, FA XKL W%,




8. Zoom
% Zoom In : 73X K
% Zoom Out : 45>
% Zoom Extents :FFiA B RAKEF
% Unzoom : P& B K 4 £ &

9. Draw
% Redraw Now : T4 W&, A AESFLLEFHA®EI, THRUAETL,
% Control Now :4=%|F @ 2 7RI,

10.  Jump
K Jump : FOUAFH EFEE AL E.
% Jump Relative : 4§ @45 £ 4582 A IT 44T,
% Nearest :J§F ARG EAF 2T Z 4G,



= . Step by Step j=4& FatF File

iGerber 344 = 4 44 FatF File T & Af 2T

Start
LG

v

Load Data
ik AE R

!

Prepare Data

HE G
Locate Part Centroids End
A E LG i A
Assign Reference Designtors Write FatF File
TERETE 7/ FatF f22{
Verify Parts Extract Netlist
AT SRR A AR

Bottom Side Parts?



T @ T MRS

4o = 4 FatF File:

1. Load Data (m# #H)

Start
CiEl G

1# ] iGerber #9% —,

Select Files
HEEERE

v

Load Aperture Lists or
Drill Racks as Needed
Hi A5 Y D-Code 1
A LE A

v

Assign Aperture Lists and
to Appropriate Layers

1B+ Aperture File 43Jic 2 ¥f
JE e

v

Load Files Using Automatic
Format Detection {5 F FH #f)
R A T AR 2

Reload Files by
Manually Specifying
Did Files Load The File Format
Correctly? > | ST AR LG
i A 75 A No THEFAE =
l Yes
Load CAD XY File Prepare Data
ik A CAD-XY fize ' HefrEort

ABRPTE AR RI I B, T K Layer List &



o, SIFile Name/Comment A4 57k 340, B BAEEZF O, LT —
BB, T —REBTA AR, BERSRFIINESD.

ﬂ Layer List

# Color Status Pol. List Pad File Hame /Comment
1 IJ Edit IEl r01 ) |C \gcplace\examplesincdrill.drl plated drills |ﬂ
bd OIJ Edit El | | |unp|ated drills |ﬂ
3 J Edit |Z| all | |t|:|p silkscreen |j
4 .I:IJ Edit |Z| all )l 1 )l |t|:|p solder paste |j
n OIJ Edit all )l 1 )l |t|:|p circuit |j
Close |
% Loading Gerber
Strat Load Aperture List
B 4G —> #ii A Aperture File

!

Assign Aperture List to Layers
-Hc Aperture File 5 5 e it

!

Load Gerber Files Using Auto Load Option
> I H B 5 ik A Gerber

No or Don’t Know l

Is an Aperture
File Needed?
== D-Code &

Does Load Data
Look Correct?

HEABRDE 7T A

Yes

No

Load Gerber Files Again Using Gerber Option | o | Load NC Data Files
81 FH Gerber EE35 K&, A Gerber Files AL




Bk A0 E B mEZ Gerber Files /&, oMk iX s Gerber Files 2 &F &
Aperture Files, 4=k Gerber Files & RS-274-X (Extended Gerber), 1& R JH
Aperture Files., 4=4 RS-274-D(Standard Gerber), W& & Aperture Files.
4o R XA A Aperture Files, 2RI THEER, 2K A4 — Aperture
File,

N |

@ Do you want to automatically add to Yoo
the list?
No
Cancel

4o Aperture File, ZZEH 2 B HLAEXIHAIF I, /224K iGerber
FiEPR, M2skd T E
H:

Load Aperture List -| [C:AGCPLACE \Sample bd]

Input Fille 0k, I
WilABoard Inc. - Cancel
Height[Y] Width[x] SHAPE DCODE
B Help

0.008 0.008 LINE D10
y . - About
0.075, 0.075, CIRCLE, D11 _ tbou |
0.068, 0.068, CIRCLE, D12
0.094, 0.094, CIRCLE., D13 Memarize |
0.050, 0.050, RECT, D14
0.050, 0.050, CIRCLE, D15 | Saue R |
n19n n non NeTaC nic _ILI Line: 1
il—l ' Colurnm: 1
Header - Scale Field Mumbers
E — 10 DCode ¥ ¥ Shape
Formnat Urits |4 ﬁ |2 jl |-| j| |3 jl
Iwhitespace j Iir‘u:h ﬂ . . .
Shapez
Draw Round Octagaon Sguare R ectangle Ohblong Annulus
Iline Iu:iru:le Iuc:t I Ireu:t I I

Carverted File - 15 apertures found, 0 af unknown shape

1010
2011
a2
4013
5014

Draw

Q.oog0ot

Round 007500
FRound 006800
Found 009400
Square 0.05000"

| »

Input File : /R45/n#Z Aperture File
Header : 45X FAAEMASEZ & JULT



Scale : AKX AT

Format : #E NI ZAAX, e EE N 4 whitespace CAXE @ X [&7))

Units : ¥4z

Field Numbers : 3AAZ|4k, 4o LB Dcode &R X% 7]

Shapes : Jw LW, BRI ALKLARA line, f Load #t iGerber SHH )T XA

Draw

fe B E R T A FHEX, T H

Diata twpe

Gerber ;I

(1].4 I
Dill
Rout Cancel |
HPGL
Emma/Quest |

DPF
DXF
EDIF 4.0.0

||

02 4o B o B B HAT AR, N E EHEA Cerber X, LdBHILTH
O, TREEMALKX. BLEEF,

Load Gerber data

Layers: IE ﬂ 1] 4 I
Error file: | ﬂ Cancel |
Format: I ﬂ Help |
Whole Digits: [2~ Print... |
Precizion: |3_ Unitz |
Abzflnc: = Absolute " Incremental

Zero Suppres.: m

Units: * jnch ¢ mm

Coords: " Abs © User

Arc style: * Quadrant ¢ Full 360

[ Flash/Draw check

¥ Modal Tool Peck

Character Set: = ASCIl " EBCDIC " ElA
[~ Magtape Filter

X Dffzet [inch): II].I]I]I]I]I]I]
Y Offset [inch): II].I]I]I]I]I]I]

[ Stop on MDD MO1

% Load NC Data Files (hn#k4:3LA%)



AR FAS R A AT XA R S5 4EIL K BLBAAS. Blde & nedrill.drl
5 ncdrill. rep ASAEE, ncdrill.drl A A474%, ncdrill. rep A#LEA
#h. BAnBAEIAE, G/ Layer lists FAONSEILAAR X BIZ, 1%
A B e, RESADrill Racks ¥ 7 A — A LRI DR,
FARBAL LA P AEILK D ——F Sk 2.

% Load CAD-XY Data
iCerber 4L Gerber Files BY, @& 204 % ol ia & 2 SUEM 4 4R,
fade R E P 5w WA CAD-XY K, HaRMabsaL@atiE], 4o Aw,
Layout 2R4F34 T VA = A RMZASEAE K, s X TAdnd iGerber F,
JEHEARK AR, B G VBT R A AL ARE T, VAT A SURAF S ARZ A ]

C42 2588 1825 0 270 00 CAPSMD {0. 1UF}
MT9 2600 1750 0 0 00 FIDUCIAL
MT3 2750 1750 0 0 00 MTHOLE1
MT7 2425 1750 0 0 00 MTHOLE1
R30 1913 1725 0 180 00 CAP0603

CAD-XY A48 % Q4R L AR, XY AR, 345 /A A S, Mok CAD-XY, &
% Files>Load CAD Centroids, HILTFTHEHIXEH 2

Load CAD Centroids - [ D:ASCRIPTINACAD XY\Mormall._prn]

— CAD Y file
aoonBoooodinooanBoonatlonnoBanoatnoannBaonaokinnooBaoanonnnBoaoal@oooaBonoalonoaBaooaki L--JEfi--]

" ¥ zd 1 part # Cancel |
107961 & 162R22 0185-00%

Li.§6EE 7016301 0164-110 Hel

Li G6EE  B.2TE0E 0164-110 4'&;:
Li.90LE . 04802 0164-110 :
F.8E9% 5.134104 130164-110 Wersion |

1. E27E 5. 500305 0164-110

"File Tupe field delimiter I [comma) units Iinch j anhgle Idegrees j

% column  © field

tab h
Header
header lines
F Y
107981 8.163R33 0192-002 LI
ref. des. 3 Y part # pka. style angle feeder  zide
Coturnn | 17 H 2 E 3 H 3z E ship E 30 H skipH &kipH
width | 3 EI 8 E 8 EI 10 E skip E 3 EI skiptﬂ skiptﬂ
Ra3 10,7981 A.163 01 92-002 1] pg
1 128622 70163 ME4-110 ]
Cz 128625 E.378 ME4-110 ]




2. Prepare Data CE&HKHD

—>

Determine Which Layers to Use
PRE(E Y e

!

Order Layers
HE e

!

Set Layer Polarity

v

Position Layers:Register,Mirror,Rotate,Offset
WOE S e, N, B

)

Set the Origin
s S

v

Convert Sketched Pads
RHEa S REE > EIH

!

Set up Physical Layers

= o=
RS

Next Step : Locate Part Centroids
T L




R B R
a. &8 Files>Set Layers FhitEiX 2 B E 2 TR 5%

Set Layer(s)

Layers: |1 j I_IDK
Status: Mo change 'I ﬂl
Image Polarity: Help |
Dl Print__. |
Apertures:

Pad color: IHu change ;I

Fad| color zelection: I j

Trace color: IHu change LI

Trace colon selection: I j

Pad Tool: I—ﬂ

Trace Tool: I j

Phyzical Layer: IHn change

Status : BTHKkA, Hide A&k
b, FEIRE EEE 2R 5KE
c. NEEZZRE, NTHRZHR, wTH

i >
[ Clear layer names Cancel |

* HAEE

HAEE, AA TR FAB AL 18], T @R 5 2 BGEE
a. Drill

Top silkscreen

Top solder paste

Top mask

Top circuit

Ground Layer

Vce Layer

e S0 a0 o

Inner Layer

Bottom circuit

—e

j. Bottom mask
k. Bottom solder paste

Bottom silkscreen



&% Files>Reorder Layers Fhfe kA EFRSE, o TFH

Layers: -. IE j oK I
Above: |1_ﬂ Cancel |
Help |
Print... |

* AFEE

A ntik, BEMmBASH L. o4t S FHH, % iGerber A ALAT,
IR S A B 5

M E PERF R LA A, 3L R T

F & Bt 2 M EARRIRR Bdit

B EZ A ER A Mark), @ %2R A Pad 3 Tool Hole

. 4 CAM>Register Layers, REHREE RFRAI—EF), &k 0K
FH L@ RAFATF

* S ATAE AL AL 2 fE

iGerber P A 43T 24545, bt £ VA% Pad. Trace. 2R EH EFE. R
BB ELAHBZIFRZRE, BT, TR T

a. B ELSTRZRE

b. ¥+F B E AL, Sk Crid>Zero Rel, A EEAR

c. ARl+FABEFPLEBZ S —LME, Lk Bdit>0ffset, BP=
LRk

* R E R

AR EE@MAERRR A . KIKEKBL, Top Mask. Bottom Mask 4 % b,
@1 Ground Layer & Vcc Layer 4o R A #K# 3L (Thermal Hole) , @75 4L 23X,
%A

* SERLZIF R

CAD #k 4+ Layout 4R RAZRSF, WA Sketched Pads (%24 Pads) H I,
BFF Sketched Pads &€ a%, iGerber Fr454a42 5B s LSRR, PTvA AR AL AT,
X IRPAT T & 2 fe:

a. ¥ Top Layer. BottomLayer. Top Mask. BottomMask. Top Paste (&=
RA693E) . Bottom Paste (wRA 6935) AKX Bdit, HANEK
sk View or Hide,

b. ¥ L3 HEAIRA

c. &1k CAM>Auto Convert Sketched Pads /KRB THALER, o TH

S



Anto Convert Bketched Padz

Top Maszk Layer[s]: I ﬂ 1] 4

Bottom Mazk Layer[s]:

o |
| _ Cancel |
Top Solder Paste: Iﬂ_ﬂ Help |
Bottom Solder Paste: Il]_ﬂ Print... |
Top Circuit Layer: Iﬂ_j Units |
Bottom Circuit Layer: Il]_ﬂ

Top lemplate Layer: & Mone  Solder Paste ¢ Solder Mask
Bottom llemplate Layer: i* Mone { Solder Paste  Solder Mask

[+ Conwert Template Layer

R adiuz [inch]: II].I]I]EI]I]I]
Length [Inch]: Il].1 hOOOoO0



3. Locate Part Centroids GEREBEERMHF SI[EE)

[ Start ] - 5 Create a Pad Scratch Layer
KA Pad 43t — et

l

Set up Layers
BRI 2 1

l

Mark All
ST Pads

l

Auto Centroid Extraction

A TIELIRE

NO

Are Found Parts

Correct?

A PFEAS 1A

YES

Fix Parts
fEsrZ




Where All SMT
Parts Found?
T SMT
T

YES

NO

Manually Extract SMT Part
Centroids T-H#HI SMT 2%
(RSN

Are There
Through Hole
Parts? & {54
DIP ZEA:

YES

\ 4

NO

Extract TH Part Insertion
Points

TEGHHIL DIP 5l

Next Setp : Assign Reference Designators
N G e AT




% #|:E PAD &
A RAE R B AT, % & Top Layer & Bottom Layer X Pad & £
B —HHE, TR

a. F Top Layer #EXi& A& Bdit, HEi&& Hide, Bdit Mode &A%

Pads+Parts

b. R @ FiA Pads

c. %k Bdit>Copy, B RAOXAAEZH AR

d. &% Bdit>Paste to, &M EE X —E, H4f Merge Layer 47%)
* REEH
¥ Pad E4MESTE, ¥R Bdit XK. LF & (silkscreen) 3% View,
£ 3LERR View, H€ W& Hide
% AT Automatic Centroid Extraction (ACE)
a. KR8 Pad EPiA SMT EAF = Pad
b. AT CAM>Automatic Centroid Extraction, X & ARG+ 2 B EE

A, FLRLE—Re 6

Find 8M T components

Hew parts laver: |3—ﬂ
BFF orientation: m Cancel I
PLCC onentation: m Help I
S50IC onentation: m Print__. I
S0T23 onentation: m
Pazzive and Polar orientation: m

Mot Placed

Up

* FRHEFREA S

sbh GIE T R AR RHUN 2 SMT B+ 5 PrA 69 DIP RA4F, R T HFRAMEZ:
a. FEEZFHHRILE TN EMHRE

b. &1k CAM>Teach Pattern, FHARVLEAANGRE

Teach Pattern

Save as: 140.000000 0.000000 ODD ﬂ
Add to List: |5|n.r|'|' Pkg. LI Cancel I
Diill Diameter (inch]: W Help |
Find Datum Bazed On: IE“tentg LI Print... |
Get datum from: " Pads+Parts ¢ Traces {* Both[pads+parts.traces] Units |
Order Pins: INune LI

c. R FTAABMZEAZ i ls
d. #AT CAM>Scan and Replace, stIhaNFFTA 5 Z 7] F Shik 2 E A4
Z R ¥ 2RI



* ERARBURZ T

A HIVEA R R b O HIRAR R, IR S B R X R M, TIRE

Mz B

a. H Pad Eixmx Bdit, XFERM&R View, BfF & &8 Bdit, HE W&

s Hide
AR R R G

#wHFEBdit>Cut FFELH AR
## Edit>Paste to M= Pad &
KR @&

-me e o

%4 CAM>ExplodeCustom Aperture 3% Part 46 & Pads

4. Assign Reference Designators (4-FedsE X4F 4 #R)

[ Start }—>

YES

Are there CAD XY
layers? & #k A
CAD-XY f&m

\ 4

NO

\ 4

Assign Reference Designators Using the
Merge CAD Centroids Function

{8 F] Merge CAD Centroids THEELFRIE
e

Assign Reference Designators
Using the Silkscreen or Assembly
Drawing fiff FH 57 247 e AT
ik

l

Next Step : Verify Parts
N BB

K £ CAD-XY A% £ 35 & BAF 4 AR

Layout 3R4F+T VA = A& CAD-XY Z B AF AR AR I F LAF, A 2 Layout 4 7R AR

Pick and Place Information, #Kik4=TF:
e. &% CAM>Merge CAD Centroids




f. 1&RB& T B3AN CAD-XY F= GC-PLACE Layer

Merge CAD-XY Parts with GC-PLACE Parts

CAD-XY Layer: || ayer 1, ERROR MARK =]
GC-PLACE Layer: |Layer 1, ERROR MARK =]
CAD-XY GC-PLACE

i - Centroid - 0

(s - Reference Designator - e

v - Part Number &

v - Fiducial Number &

- - Orientation - o
Report centroid differences greater than 0 inches

(1] 4 Cancel ‘

CAD-XY Layer: AN CAD-XY AAZE oKX & @
GC-PLACE Layer: B 3)XF3h& LHMMIEMFF &
* AL L F SRR RAM 4 AR
F B E (Parts Layer) 3%k Bdit, XLF &% Bdit, L& E&@i&m& Hide
KX FEHLFRKR, #hF—LF R, Cor 8
c. b HRIXAFMNEHLKE, TFAAIFBELFATA, £ Zero Rel
FrEER, BETFAFSELFAE LA, BPTERELF R
d. RAFHGEMHELF E
e. #AT CAM>Identify Parts,3EALF E. EMHE. LF K JE.E% 0K Bp

’6]'
Identifyr Part(s)
S5ilk Layer: IE_ﬂ
Part Layer: ll]_ﬂ Cancel
width [inch]: 0.03300 Help
Height [inch): [0.04500 Print...

W Owerwrite Units

Expected Characters: |

[ Accept Alpha-Humeric-Alpha

5. Verifying Parts (344 4R)
a. PR R Edit 82X



b. .&1& CAM>Check Reference Designators o &R LA R T EH, WwRA
Bottom Part Layer, #4650 —3kik#%, F 48 F B Compare Top and Bot tom
Layers

Reference Designator Trovbleshooter - Se b zsemnbly Layrers to check and options

Top Part Layer ILayer 10 d
Bottom Part Layer INIJI'IE d

Cancel

¥ Check Duplicates [ Compare Top and Bottom Layers |

¥ Check Blank " Fuzzy Check About

1 Match
=1 Differ,

REFDES FORMAT
{ 2

%

c. Bk OK Bp 4642, JoRA B4 MEH R, iGerber 2K E B
ﬁﬁé,%N?&Q@mwﬁﬁAﬁ&ﬁ&Z%O

6. Extract Netlist (=4 £3%)

=
!

Verify Data is Set up Properly
it TR A

!

Set all Electrical,Solder Mask and Parts
Layers to Edit,Hide all Other Layers
IR . DiSYE. ESUBR Edit
FLER et R B

!

Extract Netlist
LR BRI

!

Next Step: Write FatF File
N2 ¢ A FatF R




* AIATAE A

a. f& File>Set Physical Layers PiX 2 A & F 2L

b. £ Top.Bottom &34 B ¥+ # & Sketched Pad (342244 Pad) & 444 %, Flash
Pad (% %449 Pad)

c. Pty ABdEE. 43LE. BIRE. B4 AR Bdit, 4N R
Hide

7. Write FatF File (4 FatF#425%)
ik File>Write Direct 348
. %4 FABmaster FatF iR
c. REBTHEBEANELGR, ZAHGHEN A+ asc 9HE

Fabmaster FATF

Output File: | 3| oK |

Deszcription: | Cancel I

Drill Layers: |1 j Help |

Top Circuit Layer: Iﬂ_ﬂ Prnt._. I

Bottom Circuit Layer: Iﬂ_ﬂ
|

Internal Circuit Layers:

Top Part Layers: I

52 521 k2]

Bottom Part Layers:

|
LContour Layer: Iﬂ_ﬂ
Top 5ilk Layer: Iﬂ_ﬂ
Bottom 5ilk Layer: Iﬂ_j
|

Top Mask Layers:

>l
Bottom Maszk Layers: I ﬂ
>l

Documention Layers: |

‘Work Space : * Bed Extents ¢ Laper Extents ¢ Contour Extents
Coords: " Abs % User

d. FbA%% A FABmaster>Inp. proc>FatF An#k, doRAsE B AR 4, N
ok AR R B A RS Iperror. asc P



